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NOTE: This manual supports three different products. PalmPrint is 
our general purpose printing software, which prints a wide variety of 
information itself, and also provides printing services to other 
applications. SCS Print Server is a stripped down version of the 
software which only provides printing services to all other applications 
which choose to support it, and does not itself do any printing. And 
finally, there are special versions of SCS Print Server which support 
printing only to a single application. Most of the material in this manual 
applies to all three versions, with a few exceptions. The name of the 
application file, which you need to know when you install the software, 
is PPrint.prc is you have the full version of PalmPrint, and 
SCSPrint.prc if you have the server version. And when you go to the 
application window on your Palm to start the application, the 
PalmPrint icon is labelled "PalmPrint", while the SCS Print Server 
icon is labelled "SCS Print".

Chapter 1: Installing the Software

Installing PalmPrint in Your Palm

Whether you downloaded the software from our Web site or received it in the mail, you should have 
a file called PPrint.prc (or SCSPrint.prc, as appropriate) on your computer or floppy disk or CD. 
If you do not have the file PPrint.prc, you cannot proceed. If you do, here's how to 
install it on your Palm handheld device:

From a Macintosh:

Using MacPac Version 1: Run the program InstallApp. Click on the Select button, set the List 
Files of Type to All Files, locate and select the file PPrint.prc, and click Open. Now click on 
the Install button. The next time you HotSync your Palm, the program will be downloaded.

Using MacPac Version 2: Select the HotSync Manager from the "Instant Palm" menu on the 
upper right of your menu bar. In the HotSync menu, select Install. Click on the Add To List 
button. Locate and select the file PPrint.prc, and click Add File. The next time you HotSync your 
Palm, the program will be downloaded.

From Windows:

Using the Install software that came with PalmPrint: As part of the download or on this diskette or 
CD you should see a program named Install in the same folder as the PalmPrint software 
(PPrint). Double-click on Install, and it will copy all of the files to a new PalmPrint folder in 
your Palm folder on your computer, and at the same time will perform all the steps to install the 
software in your Palm, except for the final step of performing an actual HotSync. When you do your 
next HotSync, the software will be installed in your Palm.

If the procedure above does not work for some reason, or if your desktop computer is supporting 
multiple Palms, try the "manual" procedures described in the next few paragraphs; if those don't 
seem to apply to your setup, please consult the manual that came with your handheld device (Palm, 
Handspring Visor, Symbol SPT1500, etc.), which contains instructions on installing applications 



into the handheld

Using current Palm desktop software: Try this first: Double-click on the file PPrint.prc. If your 
system is correctly configured with the latest Palm software, a window labelled "Palm Install Tool 
3.0" (or perhaps higher) will appear. Check that the user name displayed is the name of the unit on 
which you are installing the software, change it if it isn't, and click on OK. A new window labelled 
"Palm Install Tool" will appear with a list of software to be installed in your Palm, which should 
include PPrint.prc. Click on Done to show you are done, then on OK to confirm. The next time 
you HotSync your Palm, the program will be downloaded.

If the method in the previous paragraph didn't work, try this: Start your Palm desktop software. 
Click on the Install button. Check to make sure the User name displayed at the top of the Palm 
Install Tool window which appears is the user name of the Palm handheld device on which you want 
to install the software; if not, select the correct user name. Now click on Add. Using the file browser 
which appears, locate and select the PPrint.prc file, and click Open. Now click on the Done 
button, and then on OK. The next time you HotSync your Palm, the program will be downloaded.

Using old Pilot desktop software: Run the program INSTAPP.EXE (it may be displayed simply as 
INSTAPP, depending on how you have Windows configured), which is located in the C:/PALM 
folder. Click on the Browse button, locate and select the PPrint.prc file, and click Open. Now 
click on the Install button. The next time you HotSync your Palm, the program will be 
downloaded.

Installing Companion Applications

Depending on how you obtained the software, PalmPrint often comes with several companion 
applications. These include SnailMailer (Snail.prc), which lets you print envelopes and mailing 
labels from the information in your Address Book, and Mail/P (Mail.prc), which replaces the 
standard Palm Mail program and lets you print emails. These programs are installed in the same 
manner as PalmPrint, as described above.

Starting the Application

From the Applications window on your Palm, look for the icon labelled PalmPrint (or SCS 
Print) which looks like this:

Entering Your Serial Number

If you have registered the software, and have obtained a serial number from Stevens Creek 
Software, you enter the serial number by tapping on the word *Unlicensed* in the upper right of 
the main screen. When you do, you'll see this screen appear:

Use Graffiti (or the on-screen keyboard) to enter your serial number (supplied to you by Stevens 
Creek Software); when you're done, tap on the OK button. If you enter an incorrect number, the 



software will let you know. If necessary, tap on the Cancel button to dismiss the Enter Serial 
Number screen. When you have entered the Serial Number correctly, you'll see the word 
*Unlicensed* disappear from the main screen.

If you run into a problem, this probably means that when you provided your Palm user name to 
Stevens Creek Software, you did so incorrectly. Check the name in the Enter Serial Number screen 
shown above, and write it down exactly (including case, i.e., whether the letters are upper-case 
letters like THIS or lower-case letters like this) and email it to Stevens Creek Software technical 
support and wait for a new serial number to be provided to you.

Chapter 2: Configuring the Software

On the top of the main screen when you open PalmPrint, you will see this display:

Setting the Printer Type and Baud Rate is the most important part of configuring PalmPrint. We 
choose to put it in the main screen for two reasons - first, to remind you of how you have the 
software configured, and second, to allow you to quickly change configurations if you use 
PalmPrint with more than one printer.

Printer Type

The Printer Type pop-up menu offers you these choices:

The first choice, Plain Text/None, is provided for the case when you want to use PalmPrint to 
send data to another computer, although you also may find this mode suitable for a number of small 
receipt printers which don't accept standard printer languages. In this mode PalmPrint sends out 
only the text it is asked to send, exactly as it exists. Automatic word-wrapping and page breaks are 
disabled, and no additional control characters are sent. The next choice, Text w/Breaks, is similar, 
but in this mode PalmPrint will add line breaks after the number of specified characters (as 
discussed below).

The remaining choices describe various types of printers and printer languages that are in common 
use. If you are unsure of what language your printer uses, you should consult the manual that came 
with your printer. Note that there is not a direct correlation between manufacturer and printer type. 
For example, many printers (such as many Apple LaserWriters) support PCL. Printers from many 
manufacturers support PostScript, but often PostScript is an optional capability on the printer so 



you'll need to be sure that it's installed on your particular printer. If you're completely unsure, you 
can try all the possibilities, but try Epson first, since Epson compatibility is probably the most 
common configuration for different printers.

Baud Rate

The Baud Rate pop-up menu offers you these choices:

In some cases, you will be able to choose a variety of baud rates; in other cases the baud rate is fixed 
by your printer. You will need to determine the appropriate baud rate. If you connect your Palm to 
another computer (instead of a printer) and use the "Plain Text" mode of PalmPrint to transmit 
information to a terminal emulation program (see next chapter), you'll probably be able to vary the 
baud rate within the terminal emulation program (and within PalmPrint).

You'll also see three "Infrared" choices on the pop-up menu. Select one of these to use the infrared 
(IrDA) port for printing to IrDA-capable printers. For most IrDA printers, you should select 
"Infrared," the first choice on the list. If you encounter difficulties communicating with the printer, 
then you can try the other two choices, "Infrared (Fast)" and "Infrared (Slow)" to see if you can 
reliably establish communication with either of those settings (the Seiko DPU-3445 requires a 
setting of "Infrared (Fast)". If your unit does not support IrDA (for example, it's an older, 
non-upgraded Pilot or PalmPilot), then the software won't let you select Infrared.

If you are using a serial-to-parallel converter cable, data arrive at your printer in a "parallel" mode, 
but they are sent out of the Palm as a serial transmission, and the baud rate must be set above to 
match the baud rate required by the serial-to-parallel converter. Stevens Creek Software sells two 
different cables for this task. The GA945CE9M has a 9-pin connector on one end which mates with 
either a "HotSync cable" (sold by Palm) or the cable coming from the HotSync cradle. If you are 
using this cable, set the baud rate to 9600. The GA945PP has a "Palm serial" connector on one end 
which mates directly with all Palm handheld units except the Palm V. If you are using this cable, set 
the baud rate to 57600.

If you are "printing" to terminal emulation software on your host computer (see Chapter 4), set the 
baud rate to match the baud rate in your terminal emulation software. If you are printing via cable to 
the serial port of a printer, the baud rate set in PalmPrint should match that of your printer. Some 
printers are fixed (typically at 9600 or 19200 baud - the Monarch 6015 requires 19200 baud, for 
example), while others have baud rates which can be selected. Consult your printer documentation 
for information on what the fixed baud rate of your printer is, or how to change it if it is adjustable. 
If you set the baud rate incorrectly, you will often see output on your printer, but it will consist of 
nonsense characters. If you see output like that, the likely solution is to change the baud rate. 
However some printers will not print anything until they receive the final "page eject" command, and 
if that is garbled like the rest of the page, you will see no output whatsoever. In other words, an 
incorrect baud rate is not a guarantee that you will see garbled output; you may see no output at all.



Manual Feed

If you check the Manual Feed box PalmPrint will select the manual feed tray for paper input. In all 
other cases the built-in paper tray will be used. This setting is only applicable to certain printers; on 
other printers it is ignored.

More Configuration Settings

Clicking the More button will display this screen, which allows you to choose additional settings:

Char(acter)s per line and Lines per page set the maximum values for those parameters, which 
are used by the software when it does automatic word-wrapping and page breaks. The values are set 
by default to numbers appropriate for 8 1/2 x 11" paper; change them if you wish. Set lines/page to 0 
if you are printing on continuous roll-feed paper and don't want page breaks. Characters per line has 
a maximum of 255; lines per page has a maximum of 99. However most likely neither of these 
values is correct for your printer; you are responsible for setting these numbers to values which are 
meaningful for the printer you are using.

On two printers, the chars/line is used to set the font size. On the Seiko DPU-3445, if you set the 
Chars/line to 52 (or fewer), printing will be in the standard size font for that printer; if you set the 
Chars/line to 69 (or anything larger than 52), printing will be in a small size font. On the Monarch 
6015, you can set Chars/line to 48, 42, 38, 32, or 24 (42 is "normal") to get progressively larger 
characters.

Note that characters per line will vary with the font size chosen (see below); if you print in smaller 
fonts, more characters will fit on a line. If you set the characters per line too low, and you print a 
memo which contains paragraphs longer than one line, the printing will not fill the page, like this:

This is an example of setting the
characters per line too small for the
page so that the full page is not
filled up as it should be.

If your printed page looks like this, you can safely increase the number of characters per line. On the 
other hand, if you enter a number of characters per line which is greater than the number which really 
fit on one line, than the lines will wrap around, like this:



This is an example of setting the characters per line 
too large for the
page so that each line wraps around because the 
software thinks
the paper is wider than it really is.

If your printed page looks like this, decrease the number of characters per line.

Left margin and Top margin should be self-explanatory; note that the former is measured in 
characters and the latter in lines. Note that on printers with continuous roll-feed paper, the top margin 
setting is also used at the end of the printing as a bottom margin to ensure that the paper moves past 
the cutting mechanism.

Font can be set to Courier, Times, or Helvetica. Automatic word-wrapping is only accurate if you 
select Courier font. The software counts characters only, not actual character widths, and thus the 
word-wrapping for proportional fonts (Times and Helvetica) will be approximate only. If you are 
printing material which has columns which are supposed to line up (such as a table), you must select 
the monospaced font Courier in order to get proper output. Font size can be set to 12 pt, 10 pt, and 
9 pt. Bold sets the default print to be bold rather than plain.

Orientation can be set to P (Portrait - long axis of the page vertical) or L (Landscape - long axis of 
the page horizontal). When you change orientation, the Characters per line and Lines per page will 
change, because there are actually two sets of those numbers, one for each orientation. Changes you 
make to the Characters per line or Lines per page always apply to the currently selected orientation. 
Orientation is applicable only to PCL and PostScript printers and is ignored on other 
printers.

Line termination can be CR (Carriage Return), LF (Line Feed), or CRLF (Carriage Return-Line 
Feed). This comes into play mostly when you are using PalmPrint to transfer information to 
another computer, in which case the end of line character(s) may affect how the data appears on the 
receiving computer or software. Leave this setting at CRLF if you aren't sure, or 
experiment and see what happens. When you are printing, most printers have some kind of setting 
(often set by DIP switches) which set the end of line character. Again, if you aren't sure, leave the 
setting at CRLF, but consult your printer manual for more guidance on the appropriate setting.

Auto-detect IR Printers is used to take advantage of a feature of IrDA communication, in which 
IrDA devices identify themselves by name such as "BJC-80" or "DeskJet 340". If you regularly print 
to more than one type of IrDA device, you probably want to leave this box checked. In that case, if 
you try to print to a printer which does not match the currently selected printer type (set on the main 
page), the software will automatically switch the printer type for you. This identification process 
does take a fraction of a second, though, and if you only print to one type of printer, you're probably 
better off just setting the printer type on the main screen and leaving this box unchecked.

Use CTS Transmit Flow Control should be checked when you are sending data via serial 
transmission to printers which may not have a sufficient internal buffer to accept everything being 
sent; this is particularly true with small receipt printers. This mode may also useful when you are 
using PalmPrint to send data to another computer and want to ensure the most reliable data 
transmission. If you are sending data via cable and some characters are being lost, it is almost certain 
that use of this mode will solve the problem. However you should NOT check this setting 
unless you need to, because if you do so and try to print via the serial port without being properly 
connected, the software may hang (tap Cancel if it does).



Infrared Setup and Testing

If you will be printing via infrared, you'll first want to test the IR "connection" to make sure that 
your Palm III can "talk" to your printer. After setting the Baud Rate to Infrared (see above), point 
the top of your Palm III (you can hold it level, you need not turn it so the IR port which is on the 
back side is visible) at the IR port of your printer (check your printer manual if you aren't sure where 
the IR port is). The distance is critical. You cannot be too far (our experience shows a 
maximum distance of 20 inches (50 cm), but this will vary with your handheld unit as well as your 
printer. If your batteries are weak, longer distances will be less likely to work. You also must not 
be too close. Again, distances vary, but it seems that as you get closer than 4 inches (10 cm), 
transmission can become unreliable with some printers. Now, once you have the units aligned, tap 
on the Menu icon and select Test IR Communications from the menu:

A window labelled PalmPrint Status Window will appear on your screen, and show you a message 
"Looking for IR printer..." After a few seconds, it should identify the printer, and you'll see (for five 
seconds, before it erases itself) a message like this: "Printer ID: BJC-80". If instead you get a 
message "No IR devices found within range!", you'll know that something is wrong. Check the 
obvious (did you remember to turn the printer on?) and then experiment with distance and angle. If 
you have access to another Palm III with IR, you can try pointing your Palm III at the other one 
(make sure the other one is on at the time). In this case you should see a message that says "The IR 
device found is not a printer!", which will at least let you know that your IR port is functional.

Aside from distance, the only "trick" with IR is timeout issues. If you have a failed communication, 
you may still have partially engaged the IR software in the printer. If this happens, further attempts to 
communicate will fail, because the printer acts as if it's not there. You either need to turn the printer 
off and on again, or, usually, just wait for a timeout period (15-30 seconds) for the printer IR 
software to "reset" itself. In other words, don't just keep tapping on Test IR Communications 
repeatedly, but "give it a rest" for a short time if the effort doesn't succeed.

Batteries may also be an issue. At a battery level significantly above that at which you receive a "low 
battery" warning from the Palm operating system, IR printing may fail, so for your first attempt at IR 
printing, make sure you have fresh batteries.

Once you understand the distance constraints and are successful in establishing reliable 
communications, you'll find that you can successfully communicate with the printer every time, so 
don't be discouraged by any initial failures.

Chapter 3: Printing

Printing Clipboard Contents, Memos, and ToDo Lists

After configuring PalmPrint appropriately, you can turn your attention to the bottom of the screen, 
where you will see three buttons to allow you different printing choices:



Print Clipboard prints the current contents of the Clipboard. Information is put on the Clipboard 
by other applications, using either the Copy or Cut functions in the Edit Menu of that application. 
You'll find these menu choices in all the built-in Palm applications, as well as a wide variety of other 
applications available for the Palm.

Print Memo will bring you to a new screen on which will appear a list of all your memos (showing 
you the first line or so of the memo).

There are three options for printing memos; the current option is shown on the large button in the 
center of the bottom of the screen. If you display all your memos (as selected by the "category 
selector" in the upper right hand as shown in the example above), the button reads Print All 
Memos and if you tap it, ALL your memos will be printed, one after the other (you'll actually be 
required to confirm your request in case you do this by accident). If you use the category selector to 
select just one category of memos, you'll see this instead:



Now the button on the bottom reads Print Category, and if you tap the button, all the memos in 
just that one category will be printed, one after the other.

To print just a single memo, tap the stylus on the memo you want to print (it doesn't matter whether 
you are displaying "All" categories or just one category), using the scroll arrows in the lower right of 
the screen if all your memos don't appear. The memo you select will be inverted (white text on a 
black background), like this:

The button now reads Print This Memo, and if you tap it, that's what will happen. If you tap the 
wrong memo, don't worry, just tap on another one (or tap the same one again to "unhighlight" it. Of 
course, after you print one memo, you can select another memo to print. When you're done, tap the 
Done button to return to the main screen.

There are a few special features of the memo screen. First, you'll see a Show button, which 
displays the first 1024 characters of the memo, so if you can't tell which memo you want to print 
from just the first line (which is all that is displayed), tap the Show button (note that the memo is not 
editable in this mode; to modify your memo, you must use the Palm Memo Pad application). Second, 
the memo display, unlike the display in the normal Palm Memo Pad application, skips over leading 
blank lines and blank spaces. This allows you to use PalmPrint to do such things as have a memo 
configured to print on letterhead paper, spaced down several lines to skip over the preprinted 
address, but still allows you to identify the memo in the display (instead of just seeing a blank line).

Print ToDo List pops up a small window which looks like this:



First select the category of items to be printed, or select All to print all ToDo items. If you want to 
print items which have been marked as completed, check the box, otherwise those items will be 
omitted from the output. Also check whether you want any notes attached to your ToDo items to be 
printed (or not). Tap on OK to actually print the ToDo list, or Cancel if you change your mind. The 
printout includes the ToDo item itself, any Note which is attached to the ToDo item (optional), the 
Category of the ToDo item, the Priority, and the Due Date (if one is present).

Monitoring and Cancelling Printing

When you print, the lower portion of the screen will display a small "status window" which lets you 
know what's happening. This is particularly valuable for IrDA printing, since you'll want to know if 
the transmission is occuring, and when it's done, so watch the screen and see what it says (you need 
to keep pointing the Palm at the printer while it is transmitting data!). There is a Cancel button in 
this window; if something goes wrong, or for some reason you want to abort the printout, just tap on 
Cancel.

If you are using SCS Print Server instead of PalmPrint, the three buttons described above will 
be replaced by two buttons labelled Test IR and Test Print. Tap on Test IR to test IR 
communications with your printer, and tap on Test Print to produce a simple printed message to 
verify that you have printing set up correctly. After that you won't need to interact with SCS Print 
Server directly again, you'll just print from your other application(s) which will send their 
information to SCS Print Server to print.

Advanced Printing - Control Codes and more

PalmPrint is written to be printer independent, so that if you have something that you print on one 
type of printer, you can switch to another type of printer and still get the same output. As a result of 
this, however, PalmPrint doesn't take advantage of some of the special features built into particular 
printers, which are usually accessed using special non-printing "control codes" (sometimes called 
"Escape sequences"). If you are willing to sacrifice printer independence, PalmPrint lets you embed 
these special codes directly into your memos, letting you change font size, switch to bold or italics, 
print a barcode, or a myriad of other things.

The heart of this special notation are pairs of double angle brackets - "double-less than" symbols and 
"double-greater than" symbols, surrounding one to three digits which are the numeric value of the 
control code - <<27>>,<<18>>, etc. These special symbols ARE found on the built-in keyboard of 
the Palm, but they have no Graffiti equivalent, so to create a memo containing these symbols, you'll 
need to use the built-in (pop-up) keyboard (or download them from the desktop). Once you do this 
once, doing it the second time can be done most simply by copying from the first memo and pasting 
into a new one. Note carefully: in this manual, we represent these symbols by two separate 
one-character symbols (e.g., "less than, less than") because many web browsers don't display these 
special characters properly. But the proper character to use are SINGLE characters (characters 
171and 187 respectively for those with an interest in the details), which are found in the lower right 
corner of the "Int'l" portion of the popup keyboard on the Palm.

As a simple example, "ESC"-W-1 turns on a special "double-wide" mode on a Canon printer, and 



"ESC"-W-0 turns it off. So the following memo would print with a special "headline" at the top (27 
is the numeric value of the ESC character):

<<27>>W1 This is the headline
<<27>>W0And the normal text is starting here

If you want to make a note to yourself of what you are doing with the control codes, you can take 
advantage of this special feature - if the material enclosed between the double angle brackets is 
non-numeric, it is taken as a comment and simply ignored. Since the first line of a memo is what 
shows on the list of memos, you can use this feature to make a note of the relevance of the memo 
which follows. The following example would produce the same output as the example above:

<<Memo with headline>><<27>>W1 This is the headline
<<27>>W0And the normal text is starting here

Printing Address Book Information

A "companion" application which ships with PalmPrint is called SnailMailer. You'll find both 
the SnailMailer software and a separate manual on the diskette with your PalmPrint software (or you 
can download SnailMailer from our web site). SnailMailer has two "levels." The basic software, 
which is included with PalmPrint, lets you print individual envelopes, mailing labels, and address 
book information (phone, etc.) by selecting names from your Palm Address Book. The full 
functionality of the software, which requires a separate license, lets you maintain multiple "mailing 
lists" of the names in your Address Book, and print out batches of envelopes or sheets of mailing 
labels for mass mailings. The full package also lets you perform "mail merge", combining 
information from different fields in the Address Book with a memo that you select to produce 
customized output. This feature uses a notation identical to that used above for printing special 
control codes, but with the added ability to put things like <<Last name>> or <<Address>> into the 
memo and have them filled in with information from one or more selected addresses. You can use 
this feature to print out form letters, phone lists, and lots more. For more information about 
SnailMailer, read its separate manual.

Other Sample Applications

There are several other sample applications you can download (or which you'll find on the floppy 
diskette or CD which you obtained) and use in conjunction with PalmPrint. All of these are 
provided at no charge, and provided "as is." Mail/P is a modified version of the standard Palm Mail 
application, which allows you to print email messages. Just tap on the email message to bring it up 
on screen, and you'll see a little printer icon at the bottom of the screen (as well as the choice Print 
Message in the menu if you prefer to use the menu). When you tap the button (or select the menu), 
Mail/P sends the message to PalmPrint to be printed. Mail/P is available only for PalmOS 
2.0 and 3.0 devices (the Palm III, or older units which have been upgraded with the Palm 
upgrade).

Other Applications

PalmPrint was written to allow other applications running on your Palm to use it to do the printing 
for them. For example, our Take An Order! software is one such application, which lets you do 
business in the field, taking orders (or preparing quotations) and printing receipts (or estimates) on 
the spot. To print or transmit data from such applications, you will usually find a menu item or a 
button in that application which will send the information (transparently to you) to PalmPrint for 
printing or transmission. You won't interact with PalmPrint directly in this case. However, before 
using the other application to print for the first time, you must use PalmPrint itself and configure it 



properly (as discussed in Chapter 2). When you leave PalmPrint, your configuration settings are 
saved, so that when the other applications sends data to PalmPrint, it will print correctly.

You'll find a current list of applications which support printing via PalmPrint at 
http://www.stevenscreek.com/palm/palmprint.shtml.

If another application doesn't support PalmPrint, then you may be able to use the Print 
Clipboard function described above to print information from that application. You might also want 
to write to the application's developer, and encourage them to support PalmPrint.

Chapter 4: Hardware Considerations

Serial and Parallel Connectivity

If you don't have infrared capability, one of the most difficult aspects of using PalmPrint for most 
people is getting the hardware configured properly. The Palm has a serial connector (note: the 
Handspring Visor has a USB connector, and PalmPrint supports printing ONLY via 
infrared from the Visor), and most printers have parallel input (serial connections send one bit of 
information at a time, while parallel connections send eight bits of information at once using a larger 
number of wires).

If you have a printer which accepts serial input, the connector on the printer will almost 
always be a "DB-25 female" connector. This is a long connector, slightly wider on one side than the 
other, with 13 holes on the wider side and 12 on the other side. To plug into this connector you need 
a DB-25 male cable. The standard output from the Palm, whether the Palm is in the cradle or you are 
using the "HotSync cable" available from 3Com, is a DB-9 female (9 holes, 5 on the slightly wider 
side, 4 on the other) connector. For this situation, you will need a DB-9 male to DB-25 male cable, 
an item you can find in most computer or electronics stores or catalogs.

With some printers, the "polarity" of the connection may be wrong. If you see no response from 
your printer whatsoever, it is possible that you need a "null modem" device (which swaps two of the 
lines on the input). You can find inexpensive 9-pin or 25-pin null modems at most computer and 
electronics stores.

If you have a printer which accepts parallel input, the connector on the printer will almost 
always be a "Centronics" connector. Note that you cannot simply connect a cable such as a DB-9 
male to Centronics between your Palm and your printer. Cables like that are made to take the parallel 
output of a PC (usually available on a DB-25 connector but sometimes on DB-9) to the parallel input 
of your printer. You must instead have a "serial to parallel converter", which is a more complex (and 
more expensive) device which converts the serial output of the Palm to a parallel signal which can be 
accepted by your printer. Stevens Creek Software sells two such cables, one which attaches directly 
to your Palm (except for the Palm V), and a second which attaches to your HotSync cradle. Visit the 
PalmPrint web page for details.

Notes on Specific Printers
(Mandatory & Suggested Settings)

Canon BJC-50 and BJC-80

Printer Type: Canon
Baud Rate: Infrared (Serial-to-Parallel printing is also possible to the BJC-80 only if you 



have an older Palm lacking infrared)
Notes: Both of these printers should work flawlessly with any Palm, Symbol, or Visor 
unit. There is one "catch." These printers have two "modes"; one called "BJ" and the other 
called "LQ". The printer MUST be in the "LQ" mode for it to work with PalmPrint. If 
PalmPrint does not appear to be working, check the manual that came with your printer 
for instructions on switching the printer to "LQ" mode.

Citizen PD-04

Printer Type: Epson
Baud Rate: Infrared
Left/top margins: 0
Chars/line: 46
Lines/page: 0

Citizen PN-60i

Printer Type: Epson
Baud Rate: Infrared
Left/top margins: 7/5
Chars/line: 78
Lines/page: 52

Datamax E-3202

Printer Type: ESCPOS
Baud Rate: 57600 (Serial - requires a "null modem" cable available from Datamax)
Use CTS Transmit Flow Control: checked
Left/top margins: 4/4 - Left margin setting is also used on the right; top margin is also used 
on the bottom.
Chars/line: 52 and 68 are the acceptable values A setting of 52 prints in 24 dots per character 
mode; 68 prints in 16 dots per character.
Lines/page: 0
Notes: Printer must be configured in ESCPOS mode, not Epson mode. Baud rate can be 
changed on printer, and must be set in PalmPrint to match, but there is no reason not to use 
the highest setting on both (57600).

Hewlett-Packard LaserJets

Printer Type: PCL (or PostScript if your printer accepts it, although PCL will be faster 
because fewer characters need to be transmitted).
Baud Rate: Infrared for units with built-in infrared including the 5P, 6P, and 2100; 
Serial-to-Parallel printing is also possible for almost all LaserJets and some even have serial 
ports as well.
Notes: Newer units (6P, 2100) work flawlessly with PalmPrint. The 5P's appear to be 
problematic; some work, some don't; you need to test any particular printer to see if it does 
work (there are some timing issues between the IR on the 5P and the Palm which cause this 
problem).

Hewlett-Packard DeskJet 340/350

Printer Type: PCL
Baud Rate: Infrared with the IR attachment available for this printer; otherwise 
Serial-to-Parallel printing is also possible.



Notes: No known problems or special tricks.

Monarch 6015

Printer Type: Monarch
Baud Rate: 19200 (Serial)
Use CTS Transmit Flow Control: MUST be checked
Left/top margins: 0 (or larger if desired) - Left margin setting is also used on the right; top 
margin is also used on the bottom.
Chars/line: 48, 42, 38, 32, and 24 are the acceptable values; as you decrease the number, 
the printer will printer larger and larger characters.
Lines/page: 0
Orientation: With 24 characters/line only, Landscape (L) orientation can be used to print 
"sideways" characters
Font: setting is ignored (font size is chosen on the basis of characters per line)
Notes: Print quality seems to depend on batteries so make sure batteries have a good strong 
charge.

Seiko DPU-3445

Printer Type: Seiko
Baud Rate: Infrared (Fast) [Very important; will not work in "Infrared" setting]
Left/top margins: 0 (or larger if desired) - Left margin setting is also used on the right; top 
margin is also used on the bottom.
Chars/line: 52 and 79 are the acceptable values A setting of 52 prints in 24 dots per character 
mode; 79 prints in 16 dots per character.
Lines/page: 0

Using PalmPrint to Transmit Data to A Computer

To transmit data to a computer, the connector which you use to perform a HotSync is the 
proper connector. The only "trick" here is that you must first turn off HotSync on your desktop 
computer, because you are going to establish a connection between your Palm and your computer 
which bypasses the standard HotSync software. Of course, you won't need this trick if you are 
transmitting information to a computer which is not running HotSync at all. Once you turn off 
HotSync (if necessary), start your terminal emulation software (whether standalone, or the 
Communications module of a "works" program such as ClarisWorks), configure the connection 
settings (primarily the baud rate) within your desktop software, and make sure to select the button or 
menu item which opens the connection between the terminal emulation software and the serial port of 
your computer (it is usually not opened automatically). Some step-by-step examples follow for 
software commonly available:

Using HyperTerminal (Windows 95)

If you have Windows 95, here are complete instructions for transferring information from your Palm 
to your desktop computer, using the HyperTerminal application which is included with Windows 95:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Select Start Menu -> Programs -> Accessories -> HyperTerminal
3. Double-click on Hypertrm.exe
4. The Location Information window which appears is irrelevant. You must fill in your 

area code (it won't proceed if you don't), then click OK.
5. In the Connection Description screen, enter as the Name: Palm (or anything else you 



like)
6. In the Phone Number screen, set the menu to Connect Using: Direct to Com1 (or 

whatever Com port you are using to connect your Palm).
7. In the Port Settings screen, set the Bits per second (known as the Baud rate in 

PalmPrint) to any number; try 57,600 first. Set the Data bits to 8, the Parity to None, 
the Stop bits to 1, and Flow Control to Hardware. Click OK.

8. In the Call Menu, select Connect.
9. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None, and the 

Baud Rate to the same number to selected at step 7. Now whatever you "print" from 
PalmPrint (or any other application which uses PalmPrint to do its printing) will appear 
in the HyperTerminal screen. If you select Capture Text from the Transfer menu, you 
can capture the information to a file.

10. When you exit HyperTerminal, answer Yes when asked if you want to save this 
session. An icon (which you selected at step 4 above) will appear in the HyperTerminal 
folder. In future sessions, you can just double-click on this icon, and proceed right to step 
8.

Using Terminal (Windows 3.1)

If you have Windows 3.1, here are complete instructions for transferring information from your 
Palm to your desktop computer, using the Terminal application which is included with Windows 3.1:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Start the Terminal application.
3. Select Communications from the Settings menu.
4. Set the Baud Rate; try 19,200 first. Set the Data bits to 8, the Parity to None, the Stop 

bits to 1, Flow Control to Hardware, and Connector to COM1 (or whatever port your 
Palm is connected to). Click OK.

5. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None, and the 
Baud Rate to the same number to selected at step 4. Now whatever you "print" from 
PalmPrint (or any other application which uses PalmPrint to do its printing) will appear 
in the Terminal screen. You can use Copy in the Edit menu to copy the text to your 
Clipboard, and then transfer it to another application. Our attempts to use Receive Text 
File in the Transfers menu resulted in GPF crashes of the Terminal application, so we 
can't recommend that!

Using AppleWorks/ClarisWorks (Macintosh)

The Mac doesn't come with any standard terminal emulation software, but AppleWorks (formerly 
ClarisWorks) is probably the most popular program which includes a Communications module. Here 
are complete instructions for transferring information from your Palm to your Mac using 
AppleWorks:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Start AppleWorks, and open a new Communications document.
3. Select Connection under the Settings menu. Set the Method to Serial Tool. Set the 

Current Port to the one to which your HotSync cable is attached. Configure the Baud 
Rate to whatever you like; try 57,600 first. Set Data Bits to 8, Parity to None, Stop 
Bits to 1, and Handshake to DTR & CTS. Click OK.

4. Select Open Connection in the Session menu.
5. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None, and the 

Baud Rate to the same number to selected at step 3. Now whatever you "print" from 
PalmPrint (or any other application which uses PalmPrint to do its printing) will appear 



in the Terminal screen. You can use Copy in the Edit menu to select information and then 
transfer it to other applications. Alternatively, use Capture to File in the Session menu 
to capture the text to a file; select Stop Capture when you're done.

6. When you're done, select Close Connection in the Session menu.
7. Use Save in the File menu to save the session as a document. In the future you can just 

open that document and skip right to step 4.

Using Terminal (WindowsCE)

PalmPrint can also be used to transfer data from the Palm to a WindowsCE handheld computer. 
Unlike when you connect to a desktop computer, where the same cabling you use for HotSync'ing is 
appropriate, when you connect to a WindowsCE computer you'll need a null modem device of some 
type. We have connected the two with the following setup: a DB-9 male to DB-25 male cable, a 
DB-25 null modem, and the DB-25 female to DB-9 male adapter which comes with the Palm. No 
doubt simpler connections are possible. Once the connection is made:

1. Select Start Menu -> Programs.
2. Double-click on Communications.
3. Double-click on the Terminal application.
4. Click on Make a New Connection. Set the Session Name to something appropriate 

(like Palm), set Select a Modem to Hayes Compatible (this isn't true but it will be 
ignored). Enter an Area Code and Telephone Number because you are required to; 
they too will be ignored.

5. Click on Configure and make sure to check Manual Dial; this is the only real trick. 
Configure the Baud Rate to whatever you like (you just need to set the same Baud Rate 
within PalmPrint), Data Bits to 8, Parity to None, Stop Bits to 1, and Flow Control 
to Hardware. Click OK twice.

6. Double-click on the new icon (labelled Palm in our example). A "dialing" window will 
appear briefly and then disappear; you are now connected.

7. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None, and the 
Baud Rate to the same number to selected at step 5. Now whatever you "print" from 
PalmPrint (or any other application which uses PalmPrint to do its printing) will appear 
in the Terminal screen. You can use Copy in the Edit menu to copy the text to your 
Clipboard, and then transfer it to another application.

Copyright 1997-2000 by Stevens Creek Software
All Rights Reserved

PalmPrint is a registered trademark of 3Com Corporation or its subsidiaries, used by Stevens Creek Software under express 
license


